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2 Introduction 
This Installation & Getting Started Guide provides some guidance on how to load WinGslib and 
related software, details different features of the interface, and basic operating principles. It is not 
a comprehensive guide, but rather a compilation of useful information.  

The first section (“Installation”, on page 4) describes the installation procedure for the necessary 
software programs needed for WinGslib and the additional utilities that we recommended 
installing: 

GSLIB the compiled GSLIB programs .......................................... page 4 
WinGslib the main interface to drive GSLIB...................................... page 6 
A text editor to view data files, parameter files,… .................................. page 8 
GsView a program to view PostScript output .................................. page 8 

The installation script should be followed to load the programs.  The installation programs not 
only copy the files to the right place, but ensure that all needed libraries (.dll files) are present and 
that the programs are entered into the registry.  Use the default file locations if possible; note any 
exceptions during loading. 

Once the software programs are loaded, there are some setup steps to go through for WinGslib.  
Some data files are made available on the statios web site www.statios.com to facilitate testing: 

cluster.dat a generic data file from GSLIB for testing. 
twowell.dat a petroleum data file with porosity and permeability for testing. 
red.dat a 2-D polymetallic mining data set with thickness, Au, Ag, Cu, and Zn. 
dallas.dat a Pb concentration environmental data set. 

The second section (“Working with WinGslib” on page 10) illustrates the setup and execution of 
WinGslib (sometimes using the test data): 

WinGslib Project Definition and Options ................................................ page 10 
Running Individual Programs and Viewing Results:.............................. page 15 
The Tree Structure ....................................................................................... page 18 
Preparing and Executing Batch Files................................................... page 20 

 

Note: This Getting Started guide does not give details of how to perform a geostatistical study. 
There are many interdependent steps and decisions required in a geostatistical study. The specific 
workflow must be determined for each problem.  
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3 Installation 
3.1 Loading the GSLIB Executables 
Execute the GSLIB90 script from the network, a temporary download location, or from a CD if 
you have it on that media.  The first installation screen will look similar to: 

 
There are some other standard installation windows and then the option to set the Destination 
Directory for the GSLIB executables.  The default location is advised; otherwise, make note of 
the location you choose. 

 
The next choice will be the program group to associate the GSLIB programs.  This decision is not 
critical.  In fact, the GSLIB programs are not accessed through the start/programs menu.  They 
need only be in a location for WinGslib to find them. 
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In this example, the “Geostats Stuff” folder was chosen.  The next window will be a summary of 
the chosen options requesting permission to start copying files.  Choosing “next” will start the 
copying.  The progress of the copying will be reported, for example,  

 
The programs are copied very quickly and the final “finish” screen is presented.  There is no 
choice on this screen, but to finish and accept the installation. 

 
The programs are copied very quickly and the final “finish” screen is presented.  There is no 
choice on this screen, but to finish and accept the installation. 

Some Remarks: 

• Hard disk space will be checked prior to installation. 

• The directory of programs can be deleted to reverse the installation – no system files are 
modified in the installation of GSLIB90 

• If you want to run the GSLIB programs from a DOS prompt, the directory containing the 
GSLIB executables should be included in the PATH statement in the autoexec.bat; 
otherwise, you must type in the full path to execute the programs. 
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3.2 Loading WinGslib 
Execute the wgxx script from the network, a temporary download location, or from a CD if you 
have one.  The installation program will have to be prepared.  This takes some time and the first 
screen installation screen will appear as: 

 
The choices are evident at this stage.  There are then the standard warning about running other 
programs during installation (avoid if possible) and the computer license.  Although most people 
are inclined to simply accept the license, we urge you to read it through the first time.  Among 
other things, the license limits your ability to distribute the program and limits Statios LLC 
liability regarding your use of the program.  Contact help@statios.com with questions. 

The option is now to set the Destination Directory for the WinGslib program.  The default 
location is advised; otherwise, make note of the location you choose. 

 
You may be asked to approve the name of a new directory if the installation program must create 
a new directory for installation. 

Once again, the next choice will be the program group to associate to the WinGslib programs.  
This is where you will find WinGslib through the start/programs menu.  As in the case of 
GSLIB90, a “Geostats Stuff” program group can be chosen.  The next window will be a summary 
of the chosen options requesting permission to start copying files.  Choosing “next” will start the 
copying.  The progress of the copying will be reported; it does not take long to copy the files and 
setup the program.  After copying the files, the program is registered and icons are created.  In the 
end a final “finish” screen is presented.  There is no choice on this screen, but to finish and accept 
the installation. 

Some Remarks: 

• Hard disk space will be checked prior to installation. 

mailto:help@statios.com
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• The directory of programs should not be just deleted to reverse the installation – the 
uninstall program from the Control Panel should be used. 
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3.3  An Editor 
The choice of a text editor, in general, is a deeply personal matter.  Common choices include 
textpad, windows interfaces to vi (such as Lemmy from www.sotfwareonline.org), kedit, emacs, 
notepad, …  You must choose the editor you want and make sure it is loaded on your machine.  
In presence of complete doubt, we would suggest the textpad editor (www.textpad.com), which 
has a windows interface, is quite powerful, and is easy to use. 

Note that you should have at least one editor installed automatically on your computer: notepad. 
If you believe that it is enough for your needs, you do not need to install an additional editor. 

3.4 GSVIEW – A Program to View Postscript 
Details of where to find the commonly used public PostScript viewing programs are available on 
the Statios web site (www.statios.com).  Two programs are required: 

• GhostScript, the underlying program to interpret and display PostScript 

• gsview, the user-friendly Windows interface, that drives the GhostScript program (in 
much the same way as WinGslib drives GSLIB). 

Aladdin GhostScript can be loaded first.  A file named gs601w32.exe (or something similar 
should be executed).  The first window will appear: 

 
Choosing the setup option starts the installation program unzipping the needed files.  The next 
window permitting you to customize the setup location will appear: 

 
The default directory can be chosen of changed to suit your disk organization; however, make 
note of the destination directory.  After choosing Install, you will have no further options.  The 
GhostScript program works in a batch mode.  The gsview program is the interface used by 
WinGslib. 

Aladdin GhostScript can be loaded first.  A file named gsv29w32.exe (or something with a newer 
version number) should be executed.  Similar to GhostScript, the first window will appear: 

http://www.textpad.com/
http://www.statios.com/
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Choosing the setup option starts the installation program unzipping the needed files.  The next 
window permitting you to customize the setup location will appear: 

 
You should already have GhostScript and can proceed with installation.  You will read and accept 
a copyright notice and be given the choice to associate postscript files with GSVIEW, which is a 
good option.  You must choose a destination directory or accept the default: 

 
You may be asked to accept the creation of a new directory and approve the final setup 
parameters.  Once you have accepted installation, everything is automatic. 

After installing gsview, you must run the program once.  Often (if you have no previous version 
of gsview/GhostScript on your machine), you will be asked for some further setup details such as 
preferred language. 

Some Remarks: 

• Hard disk space will be checked prior to installation. 

• The directory of programs should not be just deleted to reverse the installation – the 
uninstall program from the Control Panel should be used. 

• WinGslib does not require the very latest version of GhostScript.  There is no need to 
systematically upgrade. 

• Some versions of GhostView that can be downloaded come with GhostScript bundled in. 
In this case, the installation can be done in a single step. 
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4 Working with WinGslib 
4.1 WinGslib Project Definition and Options 

4.1.1 Main panel 

WinGslib is launched through the start/program menu, explorer, or a link copied to the desktop.  
Following is the main WinGslib window.  Most of the options are grayed-out until a project is 
defined. 

 
The first area (labeled 1 on the main window above) is a tree structure that stores a copy of all the 
parameter files executed in the current project under the correct heading.  Each heading relates to 
a menu item at the start.  You can also start a program directly from the tree structure, but more 
on these details later. 

The second area (labeled 2 on the main window above) is for preparing a batch file; it is an 
advanced feature that will be discussed later. 

The third black area in the main window is an information window where the standard output of 
all programs will be shown, that is, all of the output that would be seen at the DOS prompt or 
UNIX shell is shown here for error checking.  
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4.1.2 Options 

4.1.2.1 Files 

On first launch, the user should go to the Tools menu choice on the far right side of the menu bar 
and choose the Options selection.  The following window will appear. 

 
The editor and “Save parameter files” options may be defaulted; however, the postscript 
previewer and directory containing the GSLIB executables must be defined to run WinGslib.  The 
correct locations may be specified if all default parameters are chosen during loading.  In any 
case, it is a good idea to check. 

The first parameter is the external editor.  Pressing the file folder button permits you to browse 
for your favorite editor.  The question mark button will search automatically to find the editor.  If 
this is left blank then the notepad editor of Windows will be used.  The second parameter is the 
PostScript viewer program; point to the location you recorded when loading GhostScript/GsView.  
If you follow the defaults, then the program may have the correct location already specified.  The 
location of the GSLIB executables must also be specified. 
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4.1.2.2 Parameters 

 
If the “Default parameter files” is on and a valid directory is specified, WinGslib will look in 
this directory for parameter files when opening new models. If the parameter file corresponding 
to the model (for example, hisplt.par for the histogram plotting model) is found in the 
directory, the parameters in that file will be used as default parameters. Otherwise, hard-coded 
default parameters are used. 

If the option to “Save parameter files before runs” is on, then each set of parameters must be 
saved before executing the GSLIB program.  An old parameter file name can be specified, but 
you must approve it being overwritten.  This option is good when performing a real study because 
an audit trail can be easily constructed.  It is convenient to turn the “Save” option off when 
performing exploratory analysis; it saves time. 

Each model defined in WinGslib can contain a short comment. If the “Show comment” option 
is on, the comment will be displayed in the parameter window. 

When saving a new parameter file, WinGslib can use one of the two following methods to 
suggest a file name: 

• Use the model type and increment a number (for example, histplt001.par, histplt002.par, 
…). 

• Take the input data file and build a name from it (for example, HP_data.par if data.par is 
the input data file name). 

Select “Get parameter file name from output file name” to choose the second option. 

4.1.2.3 Setting up a New Project 

A project must be defined before WinGslib can be used with data.  Choosing the File ! New 
project selection calls up the following window. 
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By default, WinGslib works with three directories: 

• Data files 

• Output files 

• Parameter files 

However, it is perfectly acceptable to use one single directory to store all the files belonging to 
give project.  

The first tab in the project directories setup window allows you to specify all three directories. 
The second tab (see below) allows you to specify one single directory. If the “three separate 
directories” option is checked, WinGslib will automatically create and initialize the thre 
directories. 

 
 

Some Remarks: 

• For this tutorial, create a training directory called c:\statios\tutorial and copy all data 
files into this directory. 
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• Create a project where all directories are chosen to be your training directory 
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4.2 Running Individual Programs and Viewing Results: 
There are a number of pull down menus from which the interface to different programs can be 
launched: 

 
Most menus are self-explanatory.  The “File” menu controls the project settings, permits new 
projects to be opened and so on.  The “Module” menu is for other programs that are not in place 
yet.  The “PostScript” menu is for the programs that create postscript plots.  Variogram, 
Kriging, Simulation and Help menus are self-evident.  The “Postprocess” menu is for 
programs that post process multiple realizations or indicator kriging results.  The “Tools” menu 
is to set WinGslib options and to combine multiple PostScript plots on one page of printed output. 

A new “blank” parameter file is opened when the interface to a program is selected from the main 
Menu.  For this reason, in practice, this top menu should only be used for the first time a program 
is opened; afterwards, it is more convenient to open the parameter file directly from the tree 
structure (upper left corner of the main window); we discuss the tree structure more below.  You 
can import a parameter file once the interface is launched. 

For example, choosing the histplt option from the PostScript menu will launch the histplt 
interface: 

 
The interface has all of the options available in the histplt program from GSLIB; keep in mind 
that WinGslib is an interface to the programs.  These parameters in the interface are saved to a 
parameter file and then executed.  The options at the bottom of the window are mostly self-
explanatory.  There are some notes: 
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•  Import will attempt to read in parameters from an existing parameter file.  It will 
overwrite all current parameters. 

•  Save will save to the same file name (if already specified). 

•  Save As will save to a new file name that you can specify. 

•  Run will trigger a save (if that option is specified in the options) and then 
execute the program.  The main options are inactive/grayed-out while the program is 
running; the options become available again when control is passed back to the interface.  
Standard output of the GSLIB programs is presented in the black lower window on the 
main WinGslib display. 

•  View will attempt to open the output files.  If the output is PostScript, then 
GhostView will be used.  If the output is an ASCII file, then your chosen editor will be 
used.  Note that the View button may be pressed before running the programs – you may 
see old results or get a warning message. 

•  Comment allows associating a short comment with the parameter file. 

•  Close will quit the current program interface without saving anything, that is, the 
interface does not prompt for a save even if changes are made to the parameters. 

When you run the program, information is printed to the bottom window, for example, 

 
You will see whether the program executed successfully or not.  You can refer to the GSLIB 
documentation to understand any errors reported in this window.  The two icons in the lower left 
corner allow you to clear the window or save the results to a file (for documentation). 

Pressing the view results launches gsview with the output: 
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Execution of all programs proceeds in similar manner – the output may be an ASCII data file. 
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4.3 The Tree Structure 
The tree structure in the upper left corner of the main window can be particularly useful for 
keeping your parameter files organized and permitting quick review and re-running of programs.  
Following is an example tree structure expanded with one gamv.par file.  There would be more 
parameter files under this program if we had created and executed more. 

 
When you right click on main menu items, e.g., Variogram, you will get the same list of 
programs as available under that menu item at the top of the WinGslib window.  When you right 
click on a program name, e.g., gamv, you get the option to create a new parameter file.  Most 
importantly, when you right click on the name of a parameter file, e.g., 
D:\clayton\TWOWELL\gamv.par, you have at least seven choices. 

 
1. “New” will launch the interface to this program with a new parameter file. 
2. “Information” will display some information about the parameter file. 
3. “Edit” will launch the interface with this parameter file allowing you to modify some of 

the parameters and re-run. 
4. “Run” will execute the program without launching the interface.  The GSLIB output is 

written to the lower log window. 
5. “View Result” will trigger gsview or your editor to look at the output file(s) associated 

with the parameter file.  
6. “Run & View Result” will execute the program without launching the interface.  The 

GSLIB output is written to the lower log window.  Then, gsview or your editor will be 
launched with the output file(s). 

7. “Add run to batch” will add the execution of the correct GSLIB program with this 
parameter file to the batch window to the right (see later). 
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8. “Add view to batch” will add the visualization of the result to the batch window. 
9. “Delete” will delete the parameter file from the tree structure and/or the hard disk; useful 

for cleaning up your files. 

As you gain more experience you will find yourself using the tree structure for many of your 
parameter choices including the creation of new parameter files. 

Some Remarks: 

• The tree structure is saved with the project.  The parameter files will not be lost if 
WinGslib crashes or you exit without saving your project, but they will not appear 
correctly on the tree structure.  Save your project from time-to-time. 

• You can import a parameter file directly from the File ! Open parameter file menu, or 
import automatically all parameter files present in the parameter files directory with File 
! Import all parameter files. 
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4.4 Preparing and Executing Batch Files 
The batch script window in the upper right corner of the main window can be useful for 
performing repetitive calculations quickly.  Following is an example with three programs added 
to the batch file: 

(i) a variogram model calculation 

(ii) creation of a variogram plot 

(iii) viewing of the output of the variogram plot. 

 
The procedure here would be to 

1. open the vmodel interface 

2. make some changes 

3. save the parameter file 

4. run the batch script 

5. look at the resulting plot 

6. go back to step (ii) until satisfied with the final result. 

The six options at the top of the batch file window: 

•  adds the chosen program/parameter file to the batch script.  A parameter file is 
“chosen” from the tree structure to the left. 

•  adds the view command from the chosen parameter file to the batch script.  Once 
again, a parameter file is chosen from the tree structure to the left. 

•  adds a DOS command to the batch sequence. 

•  runs the batch script.  The output that would be normally written to the screen (DOS 
prompt) is written to the log window at the bottom of WinGslib. 

•  launches a file selection window so that you can load a batch file that already exists. 

•  saves the batch file – you will be asked for the name of a parameter file if this is a 
new batch file. 

•  clears the batch file window  

The batch capabilities in WinGslib are limited to straight sequence of models or DOS commands 
and do not permit loops or pattern substitution at this point.  You could consider a UNIX-type 
shell (there are good ones for the PC) and call the GSLIB programs directly from the shell. 

Note that all of the GSLIB programs operate with the parameter file as a calling argument, e.g., 
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C:\Program Files\Statios\gslib90\sgsim.exe d:\tutorial\sgsim.par 
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